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1. INSTALLING ZOTERO

Zotero is a free bibliographic referencing program, which can be download
from www.zotero.org. Zotero includes three elements:

- The Zotero program for Windows or MAC

- Zotero Connector plugin for Google Chrome, or other browsers

- MS Word Add-in Zotero Toolbar

Generally all three parts will be automatically installed at setup. If the Word
toolbar is not working, this can be reset under the Zotero preferences > Cite.

2. MANUALLY INPUTTING REFERENCES

Although it is much faster to input reference data using bibliographic databases
or using the Zotero connnector, sometimes references from books or journals
will need to be typed (or edited) in your Zotero library manually.

1. Click the page+ icon; or File> New Item

2. Select type of reference from the pull-down box, Journal Article or
Book are the most commonly used.

3. For example type in the following Journal Article

[& Info 2
Item Type Journal Article

Title Trends in incidence and outcome of stroke in Perth
Author Islam, M.S.
Author Anderson, C.S.

Publication Stroke

Volume 39

Issue 3

Pages 776-782

Date 2008

TIP: When entering Author names with initials, follow each initial with a full-
stop, ie Anderson, C.S.


http://www.zotero.org/

Zotero fields used for Book references

[& Info ~
Item Type Book
Title Basic epidemiology
Author Bonita, R.
Author Beaglehole, R.
Author Kjellstrom, T.
Series
Series Number
Volume
# of Volumes
Edition 2nd
Place Geneva
Publisher World Health Organization
Date 2006

Reference in bibliography when formatted for Vancouver (superscript) style:
1. Bonita R, Beaglehole R, Kjellstrom T. Basic epidemiology. 2nd ed. Geneva:
World Health Organization; 2006.

Reference in bibliography when formatted for Monash - Harvard style:
Bonita R, Beaglehole R and Kjellstrom T (2006) Basic epidemiology, 2nd edn,
World Health Organization, Geneva.

Reference in bibliography when formatted for APA (7t ed.):
Bonita, R., Beaglehole, R., & Kjellstrom, T. (2006). Basic epidemiology (2nd
ed.). Geneva: World Health Organization.

Please note: Zotero does not have a format for Webpage which can be
selected from the pull-down for manual entry of web references. Instead you
will need to use the Zotero Connector to extract reference data when browsing
webpages. Section 4 explains how to use the Zotero Connector.

3. CHOOSING OUTPUT STYLES

Your referencing style can be selected by either the Zotero program or via the
Word toolbar.

- Zotero program: >Edit (Windows) > Settings>Cite >Styles and choose
your style, or follow link to Get additional styles

- Word Zotero toolbar >Document preferences > Choose preferred style
from pull-down menu



How to quickly see a formatted reference for a selected Output style

Zotero does not display the formatted references within the Zotero program
window. The easiest way to do a quick check of the output that would appear
in your bibliography is to highlight a specific reference in your display list, do a
right-hand click and select Create Bibliography from Item

HIV Preexposure Prophylaxis C..  Holt et al. 2020 Journal of Acquired Immune Deficiency Syndromes (1999)

* [ How to measure blood pressu...  Saugel et al Critical Care (London, England)

: 3 : - =" Open FOF in New Tab

= Identifying the genetic associa... Zhao etal 2024 Skin research and technology : off
e =" Open POF in New Window

Investigation of Best Practices ... Lausenetal 2023 Towdns - _

Ge View Onling
= Jellyfish from Fisheries By-Catc.. D'Ambraan. 2022 Marine Drugs . T
= Leadership in women's health: ... Barbour 2024 Medical Journal of Australia P g
Lifestyle behaviour changes as_.  Ng et al. 2024 Scientific reports Adkd Mot Toam Annotations T
= Limited Sustained Local Trans... D Giallonar... 2019 Viruses Add Adtachenent » £

= Lingzhi or Reishi Medicinal Mu,.. Ratnaningty.. 2024 International journal of medicinal Add b0 Collection

Localization of Multiple Jellyfis... Klompen et al. 2023 Toxins Ll —

= Medicare-funded reproductive.. Rogersetal. 2024 Medical Journal of Australia ] Move kem to Tash gl
= Full Text PDF I, Export Hem..
Methotrexate for juvenile idio...  Tan et al. 2024 The Cochrane database of system Creste Biblingraphry fromm Bem,,

= Midterm Results after Tibiotala.. Kim et al, 2024 Clinics in orthopedic surgery H Genesate Repost from ierm...

Then from thé"plbp-‘ljp di'élb'gue box select Oﬁfpuf mode: 'Bibliograph_y and
Output Method: Copy to Clipboard, click OK.

TOTTOOOTv T

Vancouver (superscript)

L

Manage Styles...
Language: | English (US) N
Output Mode:
O Citations
® Bibliography
Qutput Method:
O Save as RTF
O Save as HTML
@® Copy to Clipboard

O Print

Cancel

Then paste the copied reference into Notepad (Windows) or TextEdit (MAC):

| *Untitled - Motepad — O >

File Edit Format View Help

1. Saugel B, Kouz K, Meidert AS, Schulte-Uentrop L, Romagnoli S.
How to measure blood pressure using an arterial catheter: a
systematic 5-step approach. Crit Care. 2020 Apr 24;24(1):172.




4. USING THE ZOTERO CONNECTOR

When browsing online resources the Zotero connector plugin can detect
documents, article pdfs and webpages and send reference data through to
your library. For website information the Zotero icon turns to a pale blue
symbol. After clicking on the symbol the Zotero Item Selector will appear, and
allow you to choose which collection to use. It is important to check what
information is actually retrieved, and correct the data if necessary.

&« > ¢ m 2z quit.org.au/articles/nicotine-re... 3§ I'| 3 &, e

C& Managed bookmarks ﬂ Alfred Intranet - Ho... [ Imported From IE Ejournals

Quit e @

Home » Micotine replacement therapy (NRT): frequently asked questions

Nicotine replacement

therapy (NRT): frequently
asked questions

[& Info ~
ltem Type Web Page
Title Nicotine Replacement Therapy (NRT) - What is NRT?
Author (last), (first)
Website Title Quit
Website Type
Date
Short Title
URL https://www.quit.org.au/articles/nicotine-replacement- ...
Accessed 8/26/2024, 1:39:02 PM
Language en
Rights
Extra
Date Added 8/26/2024, 1:39:02 PM




In the example above the subtitle of the downloaded title is incorrect and would
need to be corrected, and the author Quit Victoria needs to be input into the
author field, and removed from the Website title. After making those changes,
the cited bibliography reference would format in the Vancouver style as:

1. Quit Victoria. Nicotine Replacement Therapy (NRT) : frequently asked questions
[Internet]. [cited 2024 Aug 26]. Available from:
https://www.quit.org.au/articles/nicotine-replacement-therapy-frequently-asked-
guestions

When using a library catalogue, ejournals or health information databases the
icon of the Zotero Connector will change to represent that resource. Ejournals,
catalogues and ejournals can allow multiple items to be selected using the
Zotero Item Selector. Free PDF’s will also be automatically downloaded.

PubMed (pubmed.gov) works well with Zotero Connector.

pov/?term=tobias+stroke+surveillance+2007 w I‘1| I

O Imported From IE Ejournals %8 XE Converter & Google Resource Scheduler @ RSr Admin

rnment Here's how you know v

y of Medicine

hnology Information

tobias stroke surveillance 2007

IMdvanced Create alert Create RSS User G
Save Email Send to Sort by: | Best match — Display options {]
P results Page 1 of 1

[ ] Stroke surveillance: population-based estimates and projections for New

1 Zealand.
Cite  Tobias M, Cheung J, Carter K, Anderson C, Feigin VL.
Share A & Zotero ltem Selector - O X
° P o . .
Select which items you'd like to add to your library:
R of
Stroke surveillance: population-based estimates and projections for New Zealand.
5}/ ouanacatib for the reatment of postmenopausal osteoporosis: resulls of the LOFT multicentre, randomis{ L ™25
al
(] ¢ e
2 L DFT
cite E
vallari |
Share
B . tales J4
Ry flassaaq
rl[ Select All | [ Deselect All N

Leung AT, Kaufman KD, Sabatine MS; LOFT Investigators.




If the Zotero Connector gives the error message "An error occurred while
saving this item”, you will need to download references in the RIS format, and
then import the file into Zotero. This is explained in the next section.

5. IMPORTING REFERENCES (USING RIS FORMAT)

Databases and ejournals will generally provide a method to download citations
as a file. When using Zotero it is important to choose the RIS (or “Refman”)
format option. For instance, when exporting citations from Ovid Medline
change the format to RIS, and fields to Complete Reference, and export.

X
Export Citation(s)
ﬁ
) . . 5 Selected: 1-5
= Print B2 Emailfl [ Export 53
Default Custom
Results per page Go
View — = = |: Format
‘ RIS v ‘
Paradoxical and bimodal immune-mediated dermatological Fields
side effects of TNF-alpha inhibitors: A comprehensive
review. [Review] ‘ Complete Reference v ‘
Behrangi E, Moodi F, Jafarzadeh A, Goodarzi A
Includes

Skin Research & Technology. 30(5):e13718, 2024 May.

B Link to External Resolver

HE urL

] search History

CaHCEt

Then from Zotero go to File > Import > select the A file option and click Next

Where do you want to import from?

@ A file (BibTeX, RIS, Zotero RDF, etc)

(O Mendeley Reference Manager (online import)

Import
1+ ‘ » ThisPC » Downloads
Organize = MNew folder
3 This PC " MName Date m
3D Objects v Today (2)
[ Desktop ris (5).ris 15/05/3
==| Documents 10.1007_s00261-024-04287-6-citation.ris 15/05/3
; Downloads ~ Yesterday (4)

Select the RIS file you wish to import from your downloads folder and click
Open, and then on the next Zotero dialogue box select the options you want
and click Next to import the records into Zotero. If the Place .. into new



collection option is ticked, Zotero will not file the new references into any
specific collection. The references will be filed into a temporary “ris” collection
which allows for viewing, filing, and then deletion of the “ris” collection.

Import x z ris (3] - Zotero
Options File Edit View Tools Help
[“IPlace imported callections and items into new collection O @ M J T f =1 j M |
w i I -
File Handling @ My lerary Tltle
(® Copy files to the Zotero storage folder e Practice Assessment of ...
(D Link to files in original location 1. Intro Flndlng a care ...
Linked files cannot be synced by Zotero. 2 M .
. Methods Paradoxical an...
3. Results Study of Assoc...
4. Discussion Temporal chan...

< Back — My Publications

-+ Duplicate ltems

PDF’s and ATTACHMENTS

If you wish to link references to PDF’s (or other document types), this can be
done manually by highlighting a reference in Zotero and right-hand clicking and
selecting from the pull-down Add Attachment > File.

J
Title ~  Creator Year Publication
Finding a care plan that suitse.. Capon 2024 The Veterinary record

« Folder: EBSCOhost
= Full Text
= Full Text
= Full Text PDF
Gastrointestinal stromal tumor... Nishidaetal. 2009 Gastric Cancer
= Health literacy and older adult... Fry et al. 2024 Health promotion journal of Australia : official journal of Australian ...

Health professionals” practices... Ingram et al. 2024 Brain impairment : a multidisciplinary journal of the Australian Socie...

» [B HIV Preexposure Prophylaxis C...

How to measure blood pressu..  Saugelet = ™% (et ndon, England)
= |dentifying the genetic associa... Zhao et al Add Nate d technology : official joumnal of International Sodiet...
Investigation of Best Practices .. Lausen et fdd fttachment s File
Jellyfish from Fisheries By-Catc... D'Ambra Find Full Text Linked il
= Leadership in women's health: ... Barbour Add to Collection » e Lk
Lifestyle behaviour changes as.. Ngetal. " Duplicate kem 5
= Limited Sustained Local Trans...  Di Giallon. [ Mevetem o Trash
Lingzhi or Reishi Medicinal Mu... Ratnaning 7, Expertitem.. simal of medicinal mushrooms
= Localization of Multiple Jelyfis... Klompen Craate Bibliography from Rem...
Medicare-funded reproductive... Rogerset L& et Report from hem.. of Australia

Also available in the pull-down is Find Full Text, which will search for available
PDF’s for download. A small pdf ICON will appear on the right-hand side of
records when a pdf is attached. By double-clicking on a listed reference the
article pdf will appear for reading and making notes.



/. COLLECTIONS

References in your Zotero library can be organised by creating Collections, and
then adding or moving references by dragging and dropping. Collections can
be organised by topic, or into parts of a document project. Create a collection
by clicking on the folder+ icon. Subcollection folders can also be created within
collection folders using the right-hand click Deleting references from
collections does not remove references from the main Library.

Z File Edit View Tools Help
0 My Library
£ Q R /4 B O
~ I My Library Title ~  Creatq
&5 Assignment » = A biochemically negative ...  Krishn|
vEIMIA Article = A five-year study of needl... Haidu
B31. Intro > = A Novel Approach to Tota... Yoon §
v B Thesis > = A quick guide to survey r... Jones
531. Intro > = A Review of Toxins from C... D'Am
£32. Methods » = Alcohol use, alcohol use d... Rosta
vE33. Results > = An economic evaluation o... Bailey
EIA. Survey > = Are musculoskeletal cond...  Ferrei
CIB. Interviews » = Assessment of rheumatoi... Ben T
B1C. Statistical Findings > = Autoimmune rheumatic d... Eades
e Drerse 0 Basic epidemiology Bonitd
> HIThesis > = Bone mineral density inh... Zhan

When using the Zotero Connector you can indicate which folder you want to
file downloaded references, and later when writing documents in Word,
references to cite can also be displayed at the Collection level.

Saving to | 2 Methods v][~

| Filter Collections |

& My Library
Thesis
1. Intro
3. Results
4, Discussion
& practice

| Tags (separated by commas Done

Are musculoskeletal conditions neglected in natio...
D PubMed entry

A quick guide to survey research
D PubMed entry



8. NOTES

Notes for a specific references in a Zotero library can be created either by high-
lighting a reference and clicking on the Notes tab on the right-hand panel, or
when reading pdfs, clicking on the Notes icon.

(& Info A

Iltem Type Journal Article | ]
Title

A Novel Approach to Total Ankle Arthroplasty
with Simultaneous Structural Tibial Cut Autograft
for Anterior Tibial Bone Defects.

Author Yoon, Yeo Kwon
Author Park, Kwang Hwan

Author Shim, Dong Woo

A Novel Approach to Total Ankle Arthroplasty with Simultaneous
Structural Tibial Cut Autograft for Anterior Tibial Bone Defects.

1 Note + o~

Article mentioned by Professor Stone.

The presences of notes and other attachments like pdfs will be listed under
references. These can be viewed using the right-hand panel.

- - T =
Title ~  Creator Year Publication Y

1 Note + A
~ = Health professionals’ pract... Ingrame.. 2024 Brain impairment : a multidisciplinary journal of the Australian 5... = ) -
“One commonly reported barrier relates to organisational

“One commonly reporte... constraints, including a culture of deprioritising discharge
= Full Text planning (Cadilhac et al. 2017) and a lack of organisational
resources to support the transition from hospital (Chen et al.
= Full Text (HTML) 2020)." (Ingram et al,, 2024, p. 2)

9. USING ZOTERO WITH MICROSOFT WORD

When Zotero is installed on a computer, a Zotero toolbar is added to Microsoft
Word. Icons are available to Add/Edit Citation into the document text, and
Add/Edit Bibliography to format at the end of a document.

Other important icons are Document Preferences to select or change the
referencing style, Refresh to update the Bibliography, and Unlink Citations to
remove field codes.



H -0 -

File Home Insert Design Layout Refe

‘Hé E? 'I:"z Document Preferences
Z Z Eﬁ! Refresh

Add/Edit Add/Edit Insert o _ -
Citation Bibliography  Mote €2 Unlink Citations
Zotero

—

Class Exercise :

Document

Although stroke rates appear to be decreasing,! population ageing will intensify
the disease and the need for effective management strategies.?

Bibliography

1. Islam MS, Anderson CS, Hankey GJ, Hardie K, Carter K, Broadhurst R,
et al. Trends in incidence and outcome of stroke in Perth, Western Australia
during 1989 to 2001: the Perth Community Stroke Study. Stroke
2008;39(3):776-82.

2.  Tobias M, Cheung J, Carter K, Anderson C, Feigin VL. Stroke
surveillance: population-based estimates and projections for New Zealand.
Aust N Z J Public Health 2007;31(6):520-5.

STEPS TO USING ZOTERO WITH WORD
1. Use the Document preferences to set citation style.
2. Position cursor where you want an in-text citation placed.
3. Use Add/Edit Citation icon to open the red Zotero citation manager. To

find a reference to cite enter name or title words. Select required
reference(s) from blue suggestions. This also allow you to edit citations.




e rates appear to be decreasing, p

My Library

Trends in incidence and outcome of stroke in Perth
Islam and Anderson (2008), Stroke, 39(3), 776-782.

practice

4. Insert the citation into the document by clicking on the right-hand arrow
inside the red citation manager.

Document

Although stroke rates appear to be decreasing,{Citation} population ag

intensify the dls ced

Selected Items

A five-year study of needlestick injuries: significant reduction associated with communication, education, and convenient placement of sharps c...
Haiduven et al. (1992), Infection Control & Hospital Epidemiology, 13(5), 265-271.

5. Type Bibliography at the end of your document. Place cursor below
Bibliography heading, and click on the Add/Edit Bibliography icon.



APPENDIX
A. ZOTERO AND SYNCING YOUR LIBRARY

Zotero users have the option to create a Zotero.org account, which is very
useful as a backup of your library, and also if you use a number of devices.

Syncing can be switched on by setting up the syncing setting in Preferences.

Zotero Preferences

General Sync Search Export Cite Advanced

Settings Reset

Data Syncing
Username: AClark2024 | Unlink Account...

Choose Libraries...

Sync automatically

Sync full-text content

About Syncing

File Syncing

[V Sync attachment files in My Library using | Zotero ~
Download files | at sync time

Sync attachment files in group libraries using Zotero storage

Download files | at sync time

By using Zotero storage, you agree to become bound by its terms and conditions,

B. PREFERENCES
Suggested settings in Zotero Preferences:
General > Miscellaneous > turn automatic tagging OFF
Sync > Sync automatically ON
Cite > Style Manager > Vancouver (superscript)
Cite > Citation Options > Include URLs OFF
Suggested setting in Word Zotero Toolbar Document Preferences:

Advanced options
Use MEDLINE journal abbreviations ON



